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Foreword
ADVISOR Enterprise is a Training Management System that drives training efficiency by (a) aligning current
and future training activities to operational requirements to identify gaps, duplications and training with
minimal value; (b) forecasting and comparing the costs of viable delivery options; (c) uncovering cost
drivers; and (d) improving resource allocation. ADVISOR is built around the ADDIE model with the added
flexibility of starting the analysis at any level. ADVISOR is made up of the following 6 modules that can be
used separately or in any combination.
Module #1
Training
Analysis

Analysis: To find out “who needs to be trained, on what and why”. Improves training
decisions by identifying and prioritizing knowledge, skills and competencies needed by
each job (position) to meet organization missions and goals. In addition to establishing
a clear line of sight between employees' tasks and organization goals, ADVISOR
assesses the need and priority for training using the Difficulty, Importance and
Frequency (DIF) model. [Mission Analysis, Competency Analysis, System Analysis, Job
Task Analysis and Knowledge/Skill Gap Analysis].

Module #2
Training
Design

Design: To find out “what is the most effective and economical way to deliver training”.
Improves training decisions by rating the effectiveness as well as forecasting and
comparing the costs of alternate blends of delivery options. In addition to maximizing
training efficiency, ADVISOR minimizes costly errors by assessing the risks and impact
of eLearning and training devices on learners, learning and organization. [Media
Analysis, Cost Analysis and Training Plans].

Module #3
Fidelity
Analysis

Develop: To find out the “fidelity requirements of training devices”. Determines the
visual, tactile, olfactory, affective & auditory sensory cues requirements of training
devices by taking into account who will use the training device; training requirements
– i.e. the performance, enabling and learning objectives that will be addressed through
the training device; synthetic environment requirements; and synthetic environment
elements.

Module #4
Resource
Management

Implementation: To find out “how much money and resources are needed”. Maximizes
training efficiency by accurately forecasting and comparing budget, personnel and
resources required for one or multiple training programs using various blends of
delivery options. In addition to improving training decisions, ADVISOR facilitates
project planning and resource management by forecasting money and resources
needed to develop, deliver, administer, manage, maintain and support training
programs over life cycle. [Forecast and Optimize Training Budgets, Personnel and
Resources].

Module #5
Project
Management

Implementation: To find out “how training should be implemented”. Keeps projects on
time and within budget by developing program project plan, identifying critical paths/
milestones, assigning personnel and resources as well as monitoring progress. In
addition to anticipating potential problems and facilitating the implementation of
corrective measures, ADVISOR improves resource allocation by tracking the utilization
rates of personnel and resources. [Develop Project Plans and Track Progress].

Module #6
Performance
Analysis

Evaluation: To find out “how training impacts performance and organizational goals”.
Improves performance by zeroing in on the source of the problem and identifying
solutions that produce the desired level of productivity. Moreover, ADVISOR highlights
actions that will generate the greatest impact by assessing the feasibility of
implementing plausible solutions as well as forecasting the costs, benefits and return
on investment (ROI) of each intervention. [Performance Gap Analysis, Root Cause
Analysis and Cost Benefit Analysis].
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Chapter 1: Evaluate Performance Deficiencies
1.1 Introduction
"I need a training program on ..." is often the opening statement in what turns out to be a costly,
frustrating and unsuccessful campaign to achieve the desired performance. The rational for training
seems clear. We are implementing a new system, receiving too many complaints from our clients, not
selling enough products, etc.
Prominent researchers have demonstrated that most performance deficiencies in the workplace are due
to environmental factors which include vague expectations, insufficient and untimely feedback, limited
access to required information, inadequate tools, resources and procedures, inappropriate and
counterproductive incentives, etc. Yet, when a performance gap occurs, the default intervention is all too
often training – although it is much easier to fix the environment than people. To put it in simple terms –
if the performance gap is not due to a lack of skills and knowledge, don't train!
Even when you determine that training is necessary, is it sufficient? A training injection on its own, rarely
works if it is not part of a total performance system.
To determine how much time and resources should be allocated to a perceived problem/opportunity, the
scope of the problem/opportunity should first be defined and the assumptions validated. In other words,
who initiated the request for the analysis or training, and for what reason? Based on circumstantial
evidence and constraints, the validity of the request can be evaluated, the cost of the problem or the
value of the opportunity estimated and the need for further analysis confirmed. The minimum (best-case
scenario) and maximum (worst-case scenario) monetary impact of the problem or opportunity on
performance can also be projected.
ADVISOR is a powerful decision support tool. It analyzes a performance deficiency, detects the source of
the problem, identifies solutions – including training – that can produce the desired level of productivity
and recommends actions to maximize your return on investment (ROI). ADVISOR is based on the
published work of several experts in the field of Human Performance Technology. It guides you through
the entire needs assessment and ROI process, offers valuable insight on what should be taken into
consideration and why, and most importantly, it is simple to use.
ADVISOR generates concise charts and tables to effectively communicate the results to others, and
provides comprehensive reports to support your decision. With ADVISOR you will never have to wonder
whether you have made the right choice.
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1.2 Setup Project
To investigate the gaps between desired and actual performance key parameters should 1st be defined
within a Project. These would include the Missions/Goals (i.e., what we are trying to achieve), the Tasks
needed to achieve these missions/goals, who is performing each Task, desired outcomes and Performance
Objectives. If key parameters have not been defined, please refer to ADVISOR Mission Analysis Step by
Step Guide or ADVISOR Training Analysis User Guide on how to setup. Once the Project and key
parameters have been setup, the Project to be investigated can be selected as follows:
Step 1: Click on the
Performance Analysis folder, under the [Evaluate] tab.
Step 2: Place checkmark next to the Projects you wish to investigate.
Step 3: Click on the [Save] button to create the (project title) node under the
Analysis folder.

Performance

3
1
1
2
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1.3 Validate Performance Gap
Step 1: To identify which goals are not being met, click on
next to the (project title) node and click
the
Mission Evaluations folder.
Step 2: Click on the [Add] button.
Step 3: Input the Evaluation Date, Trigger (i.e., reason for initiating the assessment), Mission/Goal under
investigation, Actual Performance, Annual Impact, whether the performance gap is significant and
if monetary impact (i.e., Actual Impact) should be estimated using performance indicators. Data
required by ADVISOR is identified by a red asterisk (*). Of course, the more data you provide, the
better the results.
Step 4: Click on the [Save] button.
2

4

1
3
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The Desired Performance field is automatically populated after you click [Save] from the corresponding
Mission/Goal Standards field (under the Analyze tab).

Notes:
 The Actual Performance should be reported in a similar format to the Desired Performance to
facilitate the identification of the performance gap.
 If the monetary impact of the problem or opportunity is:
 Available. Input the Annual Impact and lock
the value.
 Not available. You can use the Performance Indicators defined under the
Performance
Indicators folder to estimate the Annual Impact. In this case:
 Yes should be selected for Estimate Monetary Impact field to display the
Performance
Indicators folder and the
Summary node under the (mission evaluation) node; and
 The Annual Impact field should remain unlocked
- to automatically retrieve and report the
average monetary value computed under the Summary node.
 If the Performance Gap is Acceptable or Not Applicable, then there is no need to carry on further with
the analysis.
 Each mission/goal evaluation can be archived as many times as you need. Once an analysis is archived,
changes to the current analysis will not impact data in archived versions. To archive an analysis, click
on the (mission/goal title) node, then click on the [Archive] tab, input the Version Title and click
the [Save] button. The date on which the archive was created is automatically saved with the Version
Title. A list of archived versions is available under the [View] tab. You may view an archived version
in read only mode by placing checkmark next to its title and clicking [Save]. You can delete as well as
recover an archived version (i.e., overwrite existing version). Of course, if an analysis is deleted, all
archived versions of the analysis are automatically deleted as well.
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Step 5: To input evidence supporting the current level of performance, click on the [Evidence] tab.
Step 6: Input evidence and date.

5

6

Note:
 Evidence should supplement the initial event that triggered the evaluation. Evidence may include:
 Line manager's comments
 Individual personnel comments
 Audits or inspections
 Changes in policies
 Safety reports
 Lessons learned reports
 Unit readiness reports
 Material readiness reports
 Introduction of a new piece of equipment
 Identification of a new or changed competitor
 Introduction of new job or restructuring of existing job profiles (specialty codes)

Step 7: To input the reliability of collected or examined evidence, click on the [Reliability] tab.
Step 8: Input factors considered in assessing the reliability of the evidence.

7

8
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Note:
 The following factors should be considered when evaluating the reliability of formal and informal data:
Formal Reports:
 Availability of supporting data
 Sample size and use of statistical procedures
 Sample size and assumptions related to the scalability of the problem
 Differing opinions
 Degree to which report confirms hypothesis
 Degree to which report confirms other assessments or actions
 Precision of collected data
 Reasoning used to draw conclusions
 Expert's collaboration

Informal Data
 Personal knowledge of individuals providing the data
 Level of detail
 Relationship to Task
 Availability or lack of supporting data
 Sample size and assumptions related to the scalability of the problem
 Differing opinions
 Degree to which data confirms hypothesis
 Degree to which data confirms other assessments or actions

Step 9: To document problems encountered in collecting data and venues used to overcome difficulties,
click on the [Difficulties] tab.
Step 10: Describe difficulties encountered in data collection.
Step 11: Click [Save].
11

9

1
0
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1.4 Create Performance Measures
To assist analysts in estimating the monetary value of a problem or opportunity, monetary measures can
be created. To define a Monetary Measure:
Step 1:
Step 2:
Step 3:
Step 4:
2

Click on the
Performance Indicators folder under the (Project) node.
Click on the [Add] button.
Input the Performance Measure Title and Formula used to compute the monetary value.
Click the [Save] button to create the Performance Indicator.
4

1

3

Notes:
 The Formula should capture how the monetary value of a Performance Measure is computed. It
should be written in a generic format to facilitate computations under various scenarios.
 The following operators can be used in composing a formula: "+" [Add], "-" [Subtract], "/" [Divide],
"*" [Multiple] and "( )" [Group].
 Each variable in the formula should be presented as one string, i.e., should not include spaces.
 Example #1: The annual monetary value of productivity improvement in a call center may be
measured as follows:
Calls*DaysPerYear*Employees*Value*Improvement/100
Where:
 Calls
 DaysPerYear
 Employees
 Value
 Improvement



= Average # of Calls Handled per Employee [per day]
= Average # of Days an Employee works per Year
= # of Employees that handle calls
= Average Monetary Impact/Value [per call]
= Potential Improvement [%]

Example #2: The annual monetary impact of improving aircraft inspections may be measured as
follows:
Inspections*Technicians*Value*Improvement/100
Where:
 Inspections
 Technicians
 Value
 Improvement

= Average # of Inspections Handled per Technician [per year]
= # of Individuals that Inspect Aircrafts
= Average Cost [per inspection]
= Potential Improvement [%]

By expressing Performance Measures in this format, monetary impact of performance improvement
can be readily computed, for any size call center or aircraft inspection facility.
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To provide a brief description for the variables in the formula:
Step 5: Click on
next to the (Performance Measure) node and click on the
Step 6: Input the description.
Step 7: Click the [Save] button.

Variables node.

7

5

6
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1.5 Estimate Monetary Impact of Problem
Performance Measures (Section 1.4) may be used to assess the financial impact of performance
deficiencies in multiple missions/goals. To estimate the monetary impact of a problem or an opportunity
on a mission/goal:
Step 1: Click on
next to the (Mission Evaluation) node and click on the
Performance Indicators
folder underneath.
Step 2: Place checkmarks next to relevant measures (created under Section 1.4) that can be used to assess
monetary impact of performance deficiency on the mission/goal.
Step 3: Click [Save].
3

2
1

Selected Performance Measures are presented under the

Performance Indicators folder.

Step 4: Click on the
(Performance Measure) node to display relevant fields (i.e., variables in Formula).
Step 5: Input the required data.
Step 6: Click [Save] to compute the minimum and maximum monetary impact of this measure on the
mission/goal.
6

4

5
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Step 7: Click the

Summary node to view the compiled results of all Performance Measures.

7
7

The average monetary value [(minimum + maximum) / 2] of all Performance Measures is in-turn
transferred to the Annual Impact field under the (Mission Evaluation) node, if unlocked
.

Step 8: Click on the
(Mission Evaluation) node to view the estimate of the monetary impact of
performance deficiency on mission/goal.

8

8
7
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1.6 Identify the Root Cause of the Problem
To zero in on the source of the problem, all Performance Objectives (POs) that impact the mission/goal
should be identified along with who is responsible for performing them. If Job Task Analysis has been
conducted and POs defined including impact on mission/goal (Mission Analysis Step by Step Guide),
ADVISOR will automatically identify all corresponding Jobs and (POs) that may impact the mission/goal.
Otherwise, you can add Jobs and POs as follows:
Step 1: Click on the Job Analysis folder.
Step 2: Place checkmarks next to relevant Jobs.
Step 3: Click [Save].
3

1

2

Selected Jobs are added under the

Job Analysis folder.

Step 4: Click on
next to the Job Analysis folder, then click on
next to the Job node and click
on the Performance Analysis folder.
Step 5: Click the [Add] button.
Step 6: Input the Evaluation Date, Trigger (i.e., reason for initiating the assessment), PO (Task) under
investigation, Actual Performance, whether the performance gap is significant and if root cause
analysis is needed to identify the source of the problem and plausible solutions.
5

4

6
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Notes:
 Only POs that have been setup for the Job under the [Analysis] tab can be investigated. If none have
been defined, please refer to ADVISOR Mission Analysis Step by Step Guide or Training Analysis User
Guide on how to conduct Job Task Analysis.
 Once Jobs and POs that impact missions/goals have been created, Jobs and POs that impact a specific
mission/goal can be identified by clicking on the Goals Top Down View Report node under the
Project Reports folder.
 The Actual Performance should be reported in a similar format to the Desired Performance to
facilitate the identification of the performance gap.
 If the Performance Gap is Acceptable or Not Applicable, then there is no need to carry on further with
the analysis.
 If the Performance Gap is Significant, then “Yes” should be selected for Perform Root Cause Analysis
field. This will in-turn display the
Root Cause Analysis folder,
Plausible Solutions node, and
the Report node under the (objective) node to identify the source of the problem and potential
solutions.
 Each Performance Analysis can be archived (i.e., preserved) as many times as you need. Once
archived, changes to the current analysis will not impact data in archived versions. To archive an
analysis, click on the (objective), then click on the [Archive] tab, input the Version Title and click
[Save]. The date on which the archive was created is automatically saved with the Version Title.
 A list of archived versions is available under the [View] tab. You may view an archived version in read
only mode by placing checkmark next to the title and clicking [Save]. You can also delete as well as
recover an archived version (i.e., overwrite existing version). Of course, if an analysis is deleted, all
archived versions of the analysis are automatically deleted as well.
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Step 7: Click [Save]. The Desired Performance field is automatically populated from the corresponding PO
Standards field (under the Analyze tab).
7

7

Step 8: To input evidence supporting the current level of performance, click on the [Evidence] tab.
Step 9: Input the evidence and date.
8

9

Note:
 Evidence should supplement the initial event that triggered the evaluation. Evidence may include:
 Line manager's comments
 Individual personnel comments
 Audits or inspections
 Changes in policies
 Safety reports
 Lessons learned reports
 Unit readiness reports
 Material readiness reports
 Introduction of a new piece of equipment
 Identification of a new or changed competitor
 Introduction of new or restructuring of existing job profiles (specialty codes)
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Step 10: To input the reliability of collected or examined evidence, click on the [Reliability] tab.
Step 11: Input factors considered in assessing the reliability of the evidence.

10

11

Note:
 The following factors should be considered when evaluating the reliability of formal and informal data:
Formal Reports:
 Availability of supporting data
 Sample size and use of statistical procedures
 Sample size and assumptions related to the scalability of the problem
 Differing opinions
 Degree to which report confirms hypothesis
 Degree to which report confirms other assessments or actions
 Precision of collected data
 Reasoning used to draw conclusions
 Expert's collaboration

Informal Data
 Personal knowledge of individuals providing the data
 Level of detail
 Relationship to Task
 Availability or lack of supporting data
 Sample size and assumptions related to the scalability of the problem
 Differing opinions
 Degree to which data confirms hypothesis
 Degree to which data confirms other assessments or actions

14 | P a g e
www.bnhexpertsoft.com
Copyright © BNH Expert Software Inc.

ADVISOR Performance Analysis Step-By-Step Guide

Step 12: To document problems encountered in collecting data and venues used to overcome difficulties,
click on the [Difficulties] tab.
Step 13: Describe difficulties encountered in data collection.
Step 14: Click [Save].
14

12

13

Note:
 Repeat this process for each Performance Objective under each Job.

15 | P a g e
www.bnhexpertsoft.com
Copyright © BNH Expert Software Inc.

ADVISOR Performance Analysis Step-By-Step Guide

1.7 Uncover Plausible Solutions
If the evaluation revealed a performance deficiency – i.e., a gap between desired and actual Task (PO)
performance, root cause analysis is needed to determine the source of the problem and plausible
solutions – which may include training, job aids, tools, changes to policies/procedures, and so forth. To
initiate the analysis:
Step 1: Click on next to the (objective) node and click next to the
Root Cause Analysis folder
to display the following eight (8) sections –
Employees,
Supervisors,
Feedback,
Policies, Tools, Tasks, Environment and Recruitment.
Step 2: Click on the

Employees node.

Step 3: Input Employees’ related data such as [Qualifications] and adequacy of Knowledge and Skills,
understanding of [Policies], [Interpersonal Skills], dependency and access to [Tools], quality of
[Feedback] received, attitude towards [Incentives] systems, and [Job Satisfaction] by clicking on
the corresponding Tabs.
Step 4: Click [Save].
4

3

1

2

3

Notes:
 Keep in mind that all questions are related to a specific Performance Objective.
 All fields under Supervisors, Feedback, Policies, Tools, Tasks, Environment and
Recruitment nodes should also be completed for an accurate assessment of plausible solutions.
 To facilitate data collection, six questionnaires have been provided in Appendix A of the Performance
Analysis User Guide. The forms may be completed during an interview or observation session, or
handed out to participants to complete.
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Step 5: Click the

Plausible Solutions node to view plausible solutions along with rating.

Step 6: To find out why a solution has been proposed, click on the solution title. The reasons, based on
information provided, are presented at the bottom of the screen.

6

5

6

Notes:
 You may override viable solutions recommended by ADVISOR by setting their impact to blank (null)
and locking
your selection; or recommend alternate solutions, by indicating their impact and
locking
your selection. Click the [Save] button to update viable solutions recommendations.
 Viable solutions may not necessarily be recommended. Final recommendations take into account the
feasibility of implementing viable solutions as well as their cost.
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Additional details can also be provided for Training, Job Aids, Policies and Tools as follows:
Step 7: Click on
next to the
Recommended Solutions folder.
Step 8: Click on
next to the (Solution) node, ( Job Aids, for example) and click the
folder.
Step 9: Click on the [Add] button.
Step 10: Input title and reference code.
Step 11: Click [Save] to create.
9

(Solutions)

11

10
7
8

Step 12: To display existing Job Aids for this Objective, click on the [Select Job Aids] tab.
Step 13: Place checkmarks next to desired Job Aids - i.e., job aids needed by employees to perform the
Task (Objective).
Step 14: Click [Save] to display selected Job Aids under the Job Aids folder.
14

12

13
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Chapter 2: Assess Viability of Solutions
2.1 Setup Plausible Solutions
Plausible solutions viability can be determined by examining compatibility with existing systems, money
and resource requirements as well as management, supervisors and employees attitudes towards the
proposed solutions. With costs and potential benefits in hand, anticipated return on investment (ROI)
from each solution can be calculated. Training solutions are setup under the [Design] tab (please refer to
Media Analysis Step by Step Guide or Performance Analysis User Guide) and non-training solutions under
the [Solutions] tab. To setup a non-training solution:
Step 1: Click on the [Solutions] Tab and select the
Solutions folder.
Step 2: Click on the [Add] button.
Step 3: Input general information, such as Solution Title, Solution Type, Expected Life, etc. Data required
by ADVISOR is identified by a red asterisk (*). Of course, the more data you provide, the better
the results.
Step 4: Click on the [Save] button to create the Solution.
2

4
1

1
3

Notes:
 Each solution can be archived as many times as you need. Once archived, changes to the current
analysis will not impact data in archived versions. To archive an analysis, click on the (solution title)
node, then click on the [Archive] tab, input the Version Title and click [Save]. The date on which the
archive was created is automatically saved with the Version Title.
 A list of archived versions is available under the [View] tab. You may view an archived version in read
only mode by placing checkmark next to its title and clicking [Save]. You can delete as well as recover
an archived version (i.e., overwrite existing version). Of course, if a solution is deleted, all archived
versions of the solution are automatically deleted as well.
 You may also share your analysis with colleagues (i.e., Users within the same Client) by clicking on the
Sharing tab, placing checkmarks next to their names and clicking the [Save] button.
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Step 5: Click
next to the (solution title) node and click on the
Step 6: Input the title for each option.
Step 7: Click on the [Save] button.

Options node.

7

5
6

2.2 Define Target Audience
If Jobs (Occupations) have been defined in the [Analyze] tab under the
Job Analysis folder, a
Audience folder will appear. To select the Target Audience for this solution:

Target

Step 1: Click on the
Target Audience folder.
Step 2: Place checkmarks next to appropriate jobs.
Step 3: Click [Save].
3

1

2
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To associate the current Solution with a plausible solution (identified under the
Plausible Solutions
node under an (objective), Section 1.7) – in other words to indicate that this Solution will close the
identified performance gap for this Job:
Step 4: Click on next to the
Target Audience folder, then click on next to the
(Selected Target
Audience) folder, and click on Link Solution to Performance Gap node.
Step 5: Select relevant solutions. Only Plausible Solutions that match current Solution Type are presented.
Step 6: Click [Save].
6

5

4

To indicate the number of individuals that require this solution:
Step 7: Click on the Individuals per Year node.
Step 8: Input the number of individuals that require this solution for each year.
Step 9: Click [Save].
9

7
8

Notes:
 If required, the projections can be refined further by indicating the number of individuals that require
the Solution in each month. To specify the number of individuals in each month, select the Months
option under “Estimate Number of Employees in” field under the (solution) node.
 Changes to the analysis are automatically tracked by ADVISOR including who made the change and
the date on which changes were made. The User can generate the History Report by clicking the
History icon in the top right corner.
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2.3 Assess the Effectiveness of Plausible Solutions
To assess the viability of plausible solutions:
Step 1: Click
next to the
Feasibility Analysis folder to display the following sections:
Management, Employees, Supervisors, and Resources.
Step 2: To indicate management awareness and support to Solutions, click on the Management node.
Step 3: Complete applicable fields.
Step 4: Click [Save].
4

1

3

2

Note:
 The same process should be repeated for

Employees,

Supervisors and

Resources nodes.
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To view the effectiveness of plausible solutions:
Step 5: Click the
Effectiveness node
Step 6: Click on the Solution Title to find out why a solution is not recommended or why effectiveness
has been reduced. The reasons, based on information provided, are presented at the bottom of
the screen.

6
5

6

Note:
 A 100% rating indicates a perfect match - i.e., the proposed Solution is well aligned with management,
employees, supervisors and organizational needs/expectations. A 0% rating indicates that the
proposed Solution does not meet one or more critical requirements.
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2.4 Forecast the Costs of Plausible Solutions
To forecast the costs of plausible solutions, including design, development, hardware, software,
administrative, management, maintenance and support costs:
Step 1: Click on next to the
Cost Analysis folder to display the following nodes: Basic Variables,
Development, Hardware, Software, Administrative, Management, and Support.
Step 2: Click the Development node.
Step 3: Input relevant data. You do not have to complete all fields but of course, the more data you
provide the better the results.
Step 4: Click on the [Save] button to automatically compute costs based on inputs.
4

1
2

3

Notes:
 Similar process can be used to forecast and compute
Management, and Support costs, as needed.

Hardware,

Software,

Administrative,

 To classify a cost as Direct (out of pocket expense) or Indirect (personnel/resource required), click on
the [D] or [I] button next to the field to toggle between the two.
 Clarification for each field as well as the impact of the response on the results can be viewed by clicking
on the [Help] button.
 Data can only be entered in active (white) cells. Data from previous entries or results are presented
in shaded (gray) cells. To change the value of a shaded (gray) cell, “Total Personnel Costs”, for
example, you would have to edit the fields used to compute this value, namely “Total Development
Time [hours]” or “Average Daily Cost for Developer”.
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Step 5: Click on the Summary node to view a detailed breakdown of the costs of plausible solutions
over solution life (including inflation), present value, as well as the cost per employee, under the
[Distribution] Tab.
Step 6: To view [Direct] (out of pocket) costs, [Indirect] (personnel/resource related) costs, [Upfront]1 and
[Recurring] costs as well as [Personnel] and [Resources] required to design, develop, administer,
maintain and support the solution, click on the corresponding tabs.

6

5

1

Upfront or startup costs represent the initial monetary outlay to launch the solution.
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ADVISOR automatically computes the rating for plausible solutions from most to least favorable. For each
option, key data is presented, including: rating (how well did the solution meet management, employees,
supervisors and organizational needs), Direct Up-front and Recurring Costs, as well as required resources
(i.e., Developers and Administrators). To view the ratings for plausible solutions:
Step 7: Click on next to the Summary folder and click on the ADVISOR Recommendations node.
Step 8: Click on the solution title, to find out why the rating of a solution has been reduced. The reasons,
based on information provided, are presented at the bottom of the screen.

8

7

8

Once you have examined the effectiveness and costs of plausible solutions, you can select the option that
best meets your needs, as follows:
Step 9: Click on the User Recommendation node.
Step 10: Select the desired Solution.
Step 11: Click [Save].
11

10
9
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ADVISOR automatically calculates the Return on Investment (ROI) of user recommended solution based
on its projected impact on relevant Objectives, Tasks and in-turn unit/organization missions/goals. To
view the ROI:
Step 12: Click on the

Projected ROI node.

12

Note:
 In addition to forecasting and comparing the costs of plausible solutions, the Cost Analysis module
provides insight on how funds and resources are allocated. For example, how much funds are
required to develop a solution or purchase the necessary hardware, how many working days will be
required to support employees, etc. You may also run what if scenarios such as developing solution
internally versus externally, for example, to determine impact on budget and resources.
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Chapter 3: Generate Reports
3.1 Generate Solution Report
A comprehensive business case report that documents the process used to rate the effectiveness and
compute the costs of plausible solutions can be generated as follows:
Step 1: Click on the
Solution Report node.
Step 2: Select items to be included.
Step 3: Click on the [Save] button.
3

2
1

The report is presented in html format, in a new window. You may print or save the report using the
corresponding functions in your Browser. Since the report is in html format, you can quickly advance to
any section by clicking on the corresponding title in the Table of Contents.
Step 4: To generate the report in Word click on [Generate Word Doc] button (top left corner).
Step 5: To return to ADVISOR, close the Solution Report window.
5
4
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3.2 Identify Actions Needed to Meet Goals
To identify interventions (training and non-training solutions) needed to meet current, emerging and
future challenges (i.e., achieve missions/goals) including impact, costs, benefits and return on investment
(ROI). The interventions can be identified for a specific mission/goal or a specific Task (Performance
Objective) for a particular Job. To generate a report:
Step 1: Click on the [Reports] tab, then click on next to the Maximize Training Impact [Effectiveness
& Efficiency] folder, and click on the
Identify Actions Needed to Meet Goals folder.
Step 2: Click on the [Add] button.
Step 3: Input the Report Title, Report Type (i.e., Mission or Job Profile), Client that the report is assigned
to, as well as the Project under investigation.
Step 4: Click [Save] to advance to the next screen.
2

4
1

3
1

Step 5: Place checkmarks next to the required Missions/Goals or Job Tasks, to identify actions needed to
attain the mission/goal or job task.
Step 6: Click on the [Save] button to generate.
6

5
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The report is presented in a new window. You may export the report to other file formats such as MS
Word, PDF, or print by clicking on the corresponding icon in the top left corner of the screen. To return
to ADVISOR, close the Report window.

Recommended Solutions that have not been analyzed are dimmed. To find out the costs, impact, benefits
and return on investment (ROI) of a plausible Solution, click on corresponding title “Job Aids” for example.

Remember that context sensitive help is also available for each screen by clicking on the [Help] button
and video clips on how to perform specific functions by clicking on the
icon.
Enjoy!
30 | P a g e
www.bnhexpertsoft.com
Copyright © BNH Expert Software Inc.

